LEARNING OBJECTIVES
After completing this lesson, you will be able to:
1.
2.
3.
4.

Understand the concept of 3D
Enter the 3D Workspace
Manipulate and rotate the 3D Model
Understand the difference between:
Wireframe, Surface and Solid Modeling

The following lessons are an introduction to 3D.
These lessons will give you a good understanding
of the basics of AutoCAD’s 3D program.

LESSON 14

INTRODUCTION TO 3D
We live in a three-dimensional world, yet most of our drawings represent only two dimensions. In Lesson 6 you made an isometric drawing that appeared threedimensional. In reality, it was merely two-dimensional lines drawn on angles to give
the appearance of depth.
In the following lessons you will be presented with a basic introduction to AutoCAD’s
3D techniques for constructing and manipulating objects. These lessons are designed
to give you a good start into the environment of 3D and encourage you to continue
your education in the world of CAD.
DIFFERENCES BETWEEN 2D AND 3D
Axes
In 2D drawings you see only one plane. This plane has two axes, X for horizontal and
Y for vertical. In 3D drawings an additional plane is added. This third plane is defined
by an additional axis named Z. The direction of the positive Z-axis basically comes out
of the screen toward you and gives the object height. To draw a 3D object you must
input all three, X, Y and Z axes coordinates.
A simple way to visualize these axes is to consider the X and Y axes as the ground
and the Z axis as a Tree growing up (positive Z) from the ground or the roots growing
down (negative Z) into the ground.

Origin
Origin

2D Coordinate System

3D Axes Coordinate System

BASIC TYPES OF 3D MODELS
There are 3 basic types of 3D models.
1. Wireframe models
2. Surface models
3. Solid models
A description of each starts on page 14-14.
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ENTER AutoCAD 3D WORKSPACE
AutoCAD has two 3D workspaces, 3D Basics and 3D Modeling. The following
Lessons will require the use of “3D Modeling” only.
1A
1. Select the “3D Modeling” Workspace.
A. Select the Workspace tool located in the
upper left corner.
B. Select the 3D Modeling workspace.
2. The Ribbon tabs and panels have changed as
shown below.

(Note:I have changed my background to white for clarity throughout the workbook.)
2

Remember you can place the command line top,
bottom or floating. Mine is located at the very
bottom, asshown here.

Continued on the next page...
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ENTER AutoCAD 3D WORKSPACE….continued
4. Select NEW (to start a new file) and select one of the following 3D templates from
the list of templates:
acad3D.dwt (for Imperial units)
or
Acadiso3D.dwt (for metric)
Now your screen should appear approximately as the shown below.
(Note:I have changed my background to white for clarity throughout the workbook.)
Notice the appearance of the Origin and the Cursor have changed.
They now display the Z axis.

View Cube
(see page
14-6)
Origin
Navigation
Bar

Cursor
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Viewing a 3D Model
Viewpoint
It is very important for you to be able to control how you view the 3D Model.
The process of changing the view is called selecting the Viewpoint.
(Note: Viewpoint; not viewport.)
The Viewpoint is the location where “YOU” are standing. This is a very important
concept to understand. The Model does not actually move; you move around the
model. For example, if you want to look at the South East corner of your house, you
need to walk to the South East corner of your lot and look at the corner of your house.
Your house did not move, but you are seeing the South East corner of your house. If
you want to see the Top or Plan View of your house, you would have to climb up on
the roof and look down on the house. The house did not move, you did. So in other
words, the Viewpoint is your “Point of View”.
Remember when you select a Viewpoint you are selecting where you are standing.
The view that appears on the screen is what you would see when you move to the
viewpoint and looked at the model.

How to change the Viewpoint
There are 3 methods to change the viewpoint of your model.
ViewCube, Orbit, 3D Views.
Each of these methods are described on the pages noted below.

ViewCube
Page 14-6

3D Views
Page 14-10

Orbit
Page 14-9
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ViewCube
The following is a description of the ViewCube tool and how to use it to view your
model. But the best way to understand the ViewCube is to use it. So I would like you
to OPEN the 2013-3D Demo.dwg that you downloaded from our website. Refer to
Intro-1 if you have not downloaded this file.
ViewCube Location
The ViewCube is located in the upper right corner of the drawing area. But you can
change it’s location. (Refer to ViewCube settings on page 14-8.)
Selecting a View
The ViewCube allows you to manipulate the model in order to see and work on all
sides. I have added text to the model so you can see how clicking on the ViewCube,
such as Top, automatically shows you the view of the top.

Rotating a View
After you have selected a view, such as Top, place the cursor on the ViewCube.
Rotation arrows should appear. If you click on either of the rotation arrows the view
will rotate 90 degrees clockwise or counter clockwise.
Rotation
Arrows
Rotation
Arrows
Home
tool

Returning to Original View
You may always return to the original Home view by selecting the little Home tool.
Note: The Home tool only appears when you place the cursor near the ViewCube.
You may also select a new view to become the Home view.
1. Orient the model to the preferred view.
2. Right click on the ViewCube and select Set current view as Home.
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ViewCube….continued
ViewCube Menu
If you right-click on the ViewCube the ViewCube menu will appear.

Home
This will return you to the original view that you specified as the Home View.
This is the same as selecting the Home tool.
Parallel and Perspective
Displays the View as Parallel or Perspective.

Parallel

Perspective

Perspective with Ortho Faces
If the current view is a face view it will appear as parallel.
Set Current View as Home
Selects the current view as the Home view.
When you select Home this view will be displayed.
ViewCube Setting…
Displays the ViewCube Settings dialog box shown on the next page.
Help
Takes you directly to the ViewCube content in the Help Menu
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ViewCube….continued
ViewCube Settings
To change the ViewCube settings, and you will want to, right click on the ViewCube
and select ViewCube Settings… from the list.
Most of these settings are personal preference. But I suggest that you uncheck the
two boxes that I have shown. I think it will make the manipulation of the views
smoother and less confusing. But again, it is your personal preference.
On-screen position:
Controls which corner the ViewCube is displayed.
ViewCube size:
Controls the size of the ViewCube display.
Inactive opacity:
Controls how visible the ViewCube is when inactive
only. It will display dark automatically when you
pass the cursor over it.
Show UCS menu:
Controls the display of the UCS drop-down menu
below the ViewCube.
Snap to closest view:
When using Click and Drag to rotate the View you
have a choice of it automatically snapping to the
closest View or smoothly rotating to the desired
View. This is one that I prefer to uncheck in
order to have a smooth rotation.
Zoom to extents after view change:
Each time you select a new View it also will Zoom to Extents if you select this option.
I prefer to control when Zoom is activated.
Use View transitions when switching views:
Controls how smooth the transition appears when rotating.
Orient ViewCube to current UCS: (Important)
You definitely want this one ON. Everytime you move the Origin the Cube orients itself
to match the new UCS. You will understand this one better in later lessons.
Keep scene upright:
Controls whether or not the view can be turned upside down. This reduces confusion.
Show compass below the ViewCube:
Controls the display of the compass, N, S, E, W.
Note: The settings stay with the computer not the drawing file.
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Orbit
The Orbit tool allows you to rotate around the model using the click-drag method.
This used to be the only way to freely rotate until ViewCube was added.
1. The Orbit tool can be selected using one of the following:
Ribbon = View tab / Navigate panel
or
Navigation Bar / Orbit tool
or
Keyboard = 3do

Ribbon Tool

Navigation Bar Tool

2. Click and drag the cursor to rotate the model.
3. To stop press the Esc or Enter key
4. Select the Home tool to return to the original view orientation. (See page 14-6)

Orbit
Constrains 3D Orbit along the XY plane or the Z axis
Free Orbit
Orbits in any direction without reference to the planes.
The point of view is not constrained along the XY plane of the Z axis.
Continuous Orbit
Orbits continuously. Click and drag in the direction you want the continuous orbit to
move, and then release the mouse button. The orbit continues to move in that
direction.
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Rotate the Model quickly
You may also quickly rotate the model around a pivot point.
1. Place the cursor on the ViewCube
2. Press and hold down the left mouse button and drag the cursor.
The cursor will change to 2 circular arrows.
When the model is positioned as you wish, just release the left mouse button.

Cursor

Pivot Point
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3D Views
You may prefer to rotate your model using fixed views such as Top or South West
Isometric.
1. Select 3D Views as follows:
Ribbon = View tab / Views panel / 

2. Select a View from the list.

2

The list of view options are the same as the ViewCube.
Selecting from this list or using ViewCube is the users personal preference
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Visual Styles
Description of Visual Styles
There are 12 visual styles supplied with the AutoCAD.
A visual style is a collection of customizable settings that control the display of the 3D
model in the current viewport.
1. Select the Visual Styles tools as follows:
Ribbon = View tab / Visual Styles panel / 

2. Click on any box to select it.
3. Place the cursor on each of the styles and watch the model change to give you a
preview before actually selecting the style.
Visual Styles descriptions:
2D Wireframe:
Conceptual:
Hidden:
Realistic:
Shaded:
Shaded w/ Edges:
Shades of Gray:
Sketchy:
Wireframe:
X-Ray:

All lines and curves shown in Parallel
Shades the object with cool and warm using Gooch face style.
Wireframe representation and hides lines
Shades the object with dark to light.
Smooth shading
Smooth shading and visible edges
Smooth shading and monochromatic shades of gray
Hand-sketched effect .
Lines and curves to represent the boundaries
Partial transparency
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Visual Styles Manager
The Visual Styles Manager palette allows you to modify the existing visual styles or
create new.
1. Select the Visual Styles Manager as follows:
Ribbon = View tab / Visual Styles panel / 

The Visual Styles Manager Palette will appear on the left side of the drawing area.
The next page will describe the Face Settings and Lighting. The remainder of the
selections will not be discussed but may be reviewed in the Help menu.
Select Conceptual

Visual Style tools:
Select the style box
before making
changes

Face settings and
Lighting:
Refer to the next
page.

This area not
discussed in this
workbook. Refer to
the Help menu.

Continued on the next page...
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Visual Styles Manager...continued
Face Settings
Controls the appearance of faces.
The Following is merely a sample of the
controls that AutoCAD offers.

Face Style
There are 3 Face Styles.

None

Realistic

Lighting quality
There are 3 Lighting Qualities.
Faceted: faceted appearance.
Smooth: regular quality smooth
appearance. (This is the default level)
Smoothest: High quality smooth
appearance.

Opacity
The opacity property controls the transparency of an object.

Lighting

Highlight Intensity
The size of the highlights on an object affects
the perception of shininess. A smaller, more
intense highlight makes objects look shinier
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Gooch

Wire Frame Model
A wireframe model of a box is basically 12 pieces of wire (lines). Each wire represents
an edge of the object. You can see through the object because there are no surfaces
to obscure your view. This type of model does not aid in the visualization of the 3D
object. Wireframe models have no volume or mass.
How to draw a Wireframe Box
1. Start a NEW file using acad3D.dwt
2. Draw a Rectangle, just like you would in 2D. (Select from Home tab / Draw panel)
First corner: 0,0 Second corner: 6,4
3. Zoom in closer if the rectangle seems too small.
6,4
0,0
4. Copy the Rectangle 5” above the original rectangle as follows:
a. Select the Copy command from the Modify panel.
b. Select the Rectangle then <enter>.
c. Select the basepoint as shown below.
d. Type the X, Y, Z coordinates for the new location: @ 0, 0, 5 <enter> <enter>
@0,0,5
The Copy
The Original

Basepoint

Now think about the coordinates entered. The coordinates @0, 0, 5 mean that you do
not want the new rectangle location to move in the X or Y axis. But you do want the
new rectangle location to move 5” in the positive “Z” axis.
5. Now using Line command, draw lines from the corners of the lower rectangle to the
upper rectangle.
Draw 4 lines

Note: This wireframe is
displayed as Parallel,
SE Isometric.

That is all there is to it. You have now completed a Wireframe Box. This
Wireframe can now be used as the structure for a Surface Model described on
the next page.

14-15

Surface Model
A Surface Model is like an empty cardboard box. All surfaces and edges are defined
but there is nothing inside. The model appears to be solid but it is actually an empty
shell. The hidden line removal command can be used because the front surfaces
obscure the back surfaces from view. A surface model makes a good visual
representation of a 3D object.

How to add a 3D Surface to a Wireframe structure
1. Create a Wireframe Model as shown on the previous page.

2. Type: 3dface <enter>
3. Draw a 3D Surface by snapping to the 4 corners as shown below and <enter>.
(The Shape will Close automatically.)
Note: Each surface must be created as a separate object.

1

2
2

1
3

4
3

4

First Surface

Second Surface

Your 3D Wireframe model now has 2 surfaces attached.
Now you may even use a “Visual Style”.
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Solid Models

(Refer to Lesson 15 for more detailed instructions)

It is important that you understand both Wireframe and Surface Modeling but you will
not be using either very often. Solid Modeling is the most useful and the most fun.
Solid models have edges, surfaces and mass.

Surface
Edge

Solid Models can be modified using many Solid Editing features such as the ones
described below.

Use Boolean operations:
such as Union, Subtract and Intersect to create a solid form.

Union

Subtract

Intersect

A simple shape can be:
Revolved
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Extruded & Shelled

EXERCISE 14A
INSTRUCTIONS:
1. Start a NEW file using acad3D.dwt .
2. Create the Wireframe Model shown below. (Refer to page 14-14)
3. Display the Model as follows:
SE Isometric (Refer to page 14-10)
Or
click on the corner of the ViewCube
Note:
The rectangle may appear small. Zoom in. Also,
change the color if the default color is too light. Use “Properties”.
4. Display the Model as Parallel not perspective. (Refer to page 14-7)
5. Do not dimension.
6. Save the drawing as: EX14A
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EXERCISE 14B
INSTRUCTIONS:
1. Open EX14A (If not already open)
2. Add surfaces to all 6 sides. (Refer to page 14-15)
(Use ViewCube or Orbit to rotate the model to access each side.)
3. Display as
a. SE Isometric
b. Visual Style = Conceptual (Refer to page 14-11)
c. Parallel (Refer to page 14-7)
4. Save the drawing as: EX14B
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Notes:
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